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WORK	WITH	FLOWThe	Smartsheet	AI-powered	platform	transforms	work	management	into	a	personalized,	predictive	engine	—	helping	you	work	the	way	you	want,	at	the	speed	you	need.Try	Smartsheet	for	free	Watch	a	demo	Use	cases	to	get	you	started	Roche	IT	manages	30%	more	projects	with	the	same	number	of	project	managers.	Sutherland
drives	business	efficiencies	with	process	automation.	DIRECTV	tracks	mission	critical	projects	from	inception	to	implementation.	Uber	cut	marketing	lifecycle	development	by	almost	half.	McLaren	Racing	accelerates	PMO	efficiency	and	drives	top-line	growth.	Convergint	reduces	the	time	for	customer	invoice	collection	by	over	30	days.	Sync	your
tools,	keep	teams	connectedIntegrate	your	favorite	apps	with	Smartsheet,	keeping	all	your	work	in	sync	and	your	team	in	the	loop.Learn	more	Teamwork	makes	the	dream	work,	and	with	Smartsheet,	it’s	easier	than	ever.	Collaborate	in	real-time,	share	updates,	and	keep	everyone	in	the	loop	—	work	together,	wherever	you	are.Learn	more	We	know
how	important	your	data	is.	That’s	why	we’ve	got	industry-leading	security	measures	to	keep	it	safe	and	sound,	so	you	can	focus	on	what	you	do	best.Learn	more	AI	that	keeps	your	teams	aheadSmartsheet	AI-driven	features,	like	intelligent	formulas	and	data	insights,	help	you	move	faster,	scale	smarter,	and	lead	every	project	and	portfolio	with
precision.Learn	more	Automate	repetitive	tasks	and	focus	on	what	really	matters.	With	workflow	automation,	you	can	simplify	processes,	reduce	errors,	and	save	time.Learn	more	Integrate	your	favorite	apps	with	Smartsheet,	keeping	all	your	work	in	sync	and	your	team	in	the	loop.Learn	more	Teamwork	makes	the	dream	work,	and	with	Smartsheet,
it’s	easier	than	ever.	Collaborate	in	real-time,	share	updates,	and	keep	everyone	in	the	loop—work	together,	wherever	you	are.Learn	more	We	know	how	important	your	data	is.	That’s	why	we’ve	got	industry-leading	security	measures	to	keep	it	safe	and	sound,	so	you	can	focus	on	what	you	do	best.Learn	more	Smartsheet	AI-driven	features,	like
intelligent	formulas	and	data	insights,	help	you	move	faster,	scale	smarter,	and	lead	every	project	and	portfolio	with	precision.Learn	more	Automate	repetitive	tasks	and	focus	on	what	really	matters.	With	workflow	automation,	you	can	simplify	processes,	reduce	errors,	and	save	time.Learn	more	How	can	financial	brands	set	themselves	apart	through
visual	storytelling?	Our	experts	explain	how.Learn	MoreThe	Motorsport	Images	Collections	captures	events	from	1895	to	today’s	most	recent	coverage.Discover	The	CollectionCurated,	compelling,	and	worth	your	time.	Explore	our	latest	gallery	of	Editors’	Picks.Browse	Editors'	FavoritesHow	can	financial	brands	set	themselves	apart	through	visual
storytelling?	Our	experts	explain	how.Learn	MoreThe	Motorsport	Images	Collections	captures	events	from	1895	to	today’s	most	recent	coverage.Discover	The	CollectionCurated,	compelling,	and	worth	your	time.	Explore	our	latest	gallery	of	Editors’	Picks.Browse	Editors'	FavoritesHow	can	financial	brands	set	themselves	apart	through	visual
storytelling?	Our	experts	explain	how.Learn	MoreThe	Motorsport	Images	Collections	captures	events	from	1895	to	today’s	most	recent	coverage.Discover	The	CollectionCurated,	compelling,	and	worth	your	time.	Explore	our	latest	gallery	of	Editors’	Picks.Browse	Editors'	Favorites	Share	—	copy	and	redistribute	the	material	in	any	medium	or	format
for	any	purpose,	even	commercially.	Adapt	—	remix,	transform,	and	build	upon	the	material	for	any	purpose,	even	commercially.	The	licensor	cannot	revoke	these	freedoms	as	long	as	you	follow	the	license	terms.	Attribution	—	You	must	give	appropriate	credit	,	provide	a	link	to	the	license,	and	indicate	if	changes	were	made	.	You	may	do	so	in	any
reasonable	manner,	but	not	in	any	way	that	suggests	the	licensor	endorses	you	or	your	use.	ShareAlike	—	If	you	remix,	transform,	or	build	upon	the	material,	you	must	distribute	your	contributions	under	the	same	license	as	the	original.	No	additional	restrictions	—	You	may	not	apply	legal	terms	or	technological	measures	that	legally	restrict	others
from	doing	anything	the	license	permits.	You	do	not	have	to	comply	with	the	license	for	elements	of	the	material	in	the	public	domain	or	where	your	use	is	permitted	by	an	applicable	exception	or	limitation	.	No	warranties	are	given.	The	license	may	not	give	you	all	of	the	permissions	necessary	for	your	intended	use.	For	example,	other	rights	such	as
publicity,	privacy,	or	moral	rights	may	limit	how	you	use	the	material.	In	this	article,	you’ll	find	free,	downloadable	workflow	templates	in	Microsoft	Excel,	Word,	and	PDF	formats.	Document	and	streamline	each	unique	business	process	with	a	visual	flowchart	to	ensure	continuity	and	efficiency	for	even	the	most	detail-heavy	projects.	Download
Project	Management	Workflow	Template	Excel	|	Word	|	PDF	Align	your	project	strategies,	track	project	progress,	and	streamline	each	step	in	your	project	with	this	free,	downloadable	template.	Use	this	template	to	propose	new	project	plans,	gain	approval	from	key	stakeholders,	create	actionable	steps	to	complete	the	project,	and	deliver	the	project
with	ease.	This	template	is	available	for	download	in	Microsoft	Excel,	Word,	PDF,	and	Visio	formats.	Download	Construction	Workflow	Template	Excel	|	Word	|	PDF			For	all	of	your	construction	projects,	use	this	comprehensive	workflow	template	to	document	and	track	each	step	of	a	very	detail-oriented	process.	With	space	to	document	every	step,
from	construction	preparation	to	foundation	laying	and	maintenance,	your	construction	project	will	be	easy	to	follow,	with	clearly	enumerated	steps.	This	template	is	available	for	free	use	in	Microsoft	Excel,	Word,	PDF,	and	Visio	formats.	Download	Recruiting	Workflow	Template	Excel	|	Word	|	PDF			Use	this	template	to	streamline	your	company’s
recruiting	process	and	efficiently	filter	through	resumes,	applications,	and	potential	candidates.	This	workflow	template	includes	every	crucial	detail	of	the	recruiting	process,	like	determining	selection	criteria,	interviewing	candidates,	assessing	candidates	against	criteria,	and	following	up	with	candidates	after	assessment.	Download	Software
Development	Workflow	Template	Excel	|	Word	|	PDF			As	you	develop	and	update	new	software,	use	this	workflow	template	to	ensure	that	you	don’t	miss	any	critical	steps	of	the	process.	With	space	to	document	the	six	steps	of	the	process,	including	concept,	inception,	construction	iterations,	transitions,	production,	and	retirement,	your	software
development	process	will	always	be	consistent,	efficient,	and	thorough.	Download	this	ready-made	template	in	Microsoft	Excel,	Word,	PDF,	and	Visio	formats.	Download	Healthcare	Workflow	Template	Excel	|	Word	|	PDF			Use	this	template	to	streamline	the	healthcare	process	in	order	to	ensure	that	every	patient	receives	the	best,	most	efficient	care
concerning	their	healthcare	plan.	This	workflow	documents	each	healthcare	process	from	start	to	finish,	including	key	details	like	medical	history	and	vitals	information,	procedures,	lab	tests,	and	prescription	orders.	This	template	is	available	for	free	use	in	Microsoft	Excel,	Word,	PDF,	and	Visio	templates.	Download	Document	Management	Workflow
Template	Excel	|	Word	|	PDF	Use	this	template	to	manage,	submit,	and	store	documents,	both	in	their	physical	and	digital	forms.	With	space	to	include	everything	from	document	creation	to	publish	date	and	archival	location,	you	can	safely	manage	and	track	all	documents	using	this	streamlined	workflow	template.	Download	E-Commerce	Workflow
Template	Excel	|	Word	|	PDF	In	a	world	dominated	by	online	transactions,	you	can	use	this	template	to	track	and	document	every	aspect	of	an	e-commerce	purchase.	View	the	workflow	from	order	submission	to	order	shipment,	and	refer	back	to	this	document	to	ensure	continuity	among	orders.	This	template	is	available	in	Microsoft	Excel,	Word,	and
PDF	formats.	Download	Finance	Workflow	Template	Excel	|	Word	|	PDF	This	template	offers	a	comprehensive	overview	of	the	workflow	involved	in	a	typical	finance	field.	Use	this	template	to	document	inbound	and	outbound	payments,	financial	reporting,	and	future	budgeting	and	forecasting.	This	template	is	available	for	you	to	use	and	customize	in
Microsoft	Excel,	Word,	and	PDF	formats.	Download	Architecture	Workflow	Template	Excel	|	Word	|	PDF	Use	this	template	to	document	and	track	the	process	associated	with	the	architecture	or	design	of	a	project.	This	template	outlines	the	steps	involved	in	creating	an	architectural	idea,	gaining	approval,	gathering	appropriate	permit	documents,
and	selecting	a	general	contractor.	Maintain	this	structure	throughout	every	architecture-based	project	with	this	free	workflow	template.	Download	Sales	Process	Workflow	Template	Excel	|	Word	|	PDF	Use	this	template	to	establish	a	consistent	plan	for	sales	lead	generation	and	follow-up,	ensuring	you	never	miss	a	potential	revenue-earning
opportunity.	This	template	includes	a	process	map	that	indicates	marketing	campaigns,	how	to	follow	up	with	qualified	leads,	what	information	to	gather	from	each	lead,	and	how	to	turn	a	lead	into	a	sales	opportunity.	Download	Manufacturing	Workflow	Template	Excel	|	Word	|	PDF	Document	the	manufacturing	process	from	start	to	finish	to	remain
consistent	and	thorough	during	every	step	of	the	process.	Include	key	details	in	the	manufacturing	industry,	such	as	suppliers,	raw	materials,	quality	assurance,	and	packaging,	to	ensure	that	each	product	is	manufactured	with	efficiency	and	accuracy.	Workflow	templates	are	a	crucial	part	of	every	business,	as	they	help	to	visualize	the	working	and
thinking	behind	each	process	that	goes	into	a	larger	project.	Workflow	templates	showcase	a	graphic	illustration	of	sequential	steps,	making	understanding,	following,	and	analyzing	the	steps	easier	and	more	effective	for	the	end	user.	Additionally,	workflow	templates	describe	the	order	in	which	steps	must	be	completed	in	a	visually	satisfying
manner,	determining	specific	activities	in	a	structured,	easy-to-follow	format.	You	can	easily	identify	and	make	changes	within	a	process	to	render	even	the	most	common	business	situations	more	efficient.	Workflow	templates	communicate	how	to	handle	and	carry	out	a	process	or	project,	and	the	visual	flowchart	or	diagram,	providing	a	structured
format,	helps	to	make	the	process	even	easier	to	follow.	Capture,	visualize,	and	build	process	requirements	unique	to	each	business	process	and	vertical,	from	project	management	to	healthcare	and	even	construction.	Customize	your	workflow	template	with	columns,	headings,	metrics,	and	data	that	you	have	to	track	or	include,	and	document
targeted	rules	for	a	workflow,	including	approval,	order	of	approval,	and	the	steps	that	ensue	after	an	approval.	A	workflow	template	can	seem	cumbersome	and	unnecessary	in	a	business	process,	as	it	outlines	and	details	even	the	simplest	of	tasks.	However,	workflow	templates	are	an	extremely	helpful	resource	in	identifying	key	details,	including
the	following:	Appropriate	team	members	for	each	process	Areas	for	improvement	or	a	process	that	could	increase	efficiency	Data	collection	or	monitoring	Approval	processes	and	key	stakeholders	who	provide	approval	Additionally,	workflow	templates	can	make	even	the	most	complex,	detailed	processes	more	understandable,	clear,	and	concise	—
this	helps	to	not	overwhelm	anyone	learning	or	carrying	out	a	detailed	process.	Workflow	templates	can	also	help	businesses	and	their	team	members	do	the	following:	Easily	show	the	flow	between	steps.	Define,	analyze,	and	discuss	any	part	of	the	process.	Standardize	a	process,	and	find	and	identify	any	gaps	in	the	process.	Identify	and	eliminate
any	processes	that	are	not	adding	value	to	the	business.	Facilitate	communication	and	teamwork	among	team	members.	Keep	everyone	on	the	same	page	about	a	process	and	its	ensuing	processes.	Provide	a	clear	understanding	of	a	process,	why	it’s	carried	out,	and	the	business	value	of	the	process.	People	tend	to	veer	away	from	using	workflows	for
a	variety	of	reasons.	They	may	be	hesitant	to	disrupt	an	already-existing	process,	want	to	maintain	complete	control	over	a	process	and	try	things	themselves,	or	want	to	construct	their	own	unique	process	that	doesn’t	follow	a	preformatted	structure.	However,	workflow	templates	help	to	provide	consistency	and	efficiency	for	all	unique	processes,
increasing	overall	control	and	effectiveness	of	processes	as	they	are	carried	out	by	other	team	members.	Workflow	diagrams	can	help	businesses	who	employ	them	in	several	ways	—	for	instance,	by	creating	an	efficient	approval	process,	assigning	resources	and	participants	to	specific	parts	of	the	process,	postponing	or	restarting	workflow	activities
with	ease,	and	designing	workflow	conditions	or	specifications.	In	addition	to	the	aforementioned	benefits,	workflow	diagrams	offer	the	following	capabilities:	Specify	the	frequency	of	tasks	and	the	ideal	amount	of	time	it	should	take	to	complete	each	task.	Include	task	instructions	for	each	process	or	an	individual	step	in	the	process.	Initiate	the
workflow	after	preceding	steps,	either	automatically	or	manually.	Send	documents	to	key	stakeholders	for	approval	after	step	or	process	completion,	and	create	one-time	reviews	for	time	efficiency.	Set	approval	status	and	ensure	steps	are	carried	out	only	after	approval	is	granted.	Pause	or	stop	the	workflow	at	a	specific	step,	or	until	a	specified	date.
Set	the	workflow	status	and	send	updates	to	any	involved	resources.	Update	steps	directly	within	the	workflow	to	increase	efficiency.	As	you	begin	creating	your	own	workflow	diagram	for	your	unique	business	process,	consider	the	purpose	for	diagramming	your	workflow,	whether	to	streamline	a	process	or	make	a	process	less	confusing	overall.
Make	sure	you	understand	the	entire	process,	from	start	to	finish,	and	identify	the	basic	steps	of	the	process	to	ensure	that	those	are	highlighted	and	included	within	the	diagram.	Document	clear	start	and	end	points	for	the	process,	and,	as	you	progress,	draft	the	steps	that	occur	in	between	these	two	points	of	the	process.	Look	for	alternate	ways	to
complete	each	process,	and	make	sure	to	note	each	exception	within	the	diagram.	Doing	this	will	give	you	and	your	team	members	the	flexibility	to	customize	the	workflow	as	it	progresses,	as	pointing	out	exceptions	will	force	you	to	keep	only	the	most	efficient	steps	of	each	process.	Microsoft	Word	offers	a	variety	of	free	workflow	templates	that	you
can	use	to	design	and	format	your	own	workflow	template.	Follow	the	steps	below	to	achieve	the	best	results:	Open	Microsoft	Word.	In	the	window,	select	the	Lightbulb	icon	at	the	top	of	the	page,	and	search	for	“Workflows.”	Choose	the	related	link	that	comes	up	under	the	“Workflows”	search.	Select	a	workflow	template	that	suits	your	needs,	and
click	OK.	Create	and	fill	out	the	workflow	template	based	on	your	unique	business	process	by	editing	or	adding	workflow	steps.	Microsoft	Excel	has	preformatted	workflow	templates	within	its	platform,	which	you	can	download	and	customize	for	your	needs.	To	access	these	templates,	follow	these	steps:	Open	Microsoft	Excel.	Using	the	search	bar	at
the	top	of	the	Excel	workbook,	search	for	“Workflow	Templates.”	In	the	Flowcharts	Template	Workbook,	you	will	find	a	variety	of	existing	workflow	templates.	Select	the	one	appropriate	for	your	business	needs,	and	click	Create	to	open	the	worksheet.	Create	and	fill	out	the	workflow	template	based	on	your	unique	business	process	by	editing	or
adding	workflow	steps.	Microsoft	PowerPoint	offers	a	unique	capability	called	SmartArt	that	allows	users	to	insert	premade	flowcharts	directly	into	a	PowerPoint	slide.	To	access	this	feature,	follow	these	sequential	steps:	Open	Microsoft	PowerPoint.	Select	the	Insert	tab	at	the	top	of	the	screen	in	the	Illustrations	Group,	and	select	SmartArt.	In	the
SmartArt	Gallery,	click	the	Process	tab.	Here,	you	will	find	a	large	quantity	of	flowchart	templates.	Select	the	SmartArt	process	template	that	suits	you,	and	insert	it	into	the	PowerPoint.	Edit	the	template	for	your	process.	You	can	insert	both	text	and	pictures	within	the	template	to	efficiently	explain	and	represent	you	process	as	needed.	Visio	offers
every	from	basic	to	detailed	workflow	templates	that	outline	business	process	with	shapes,	images,	and	text.	Follow	these	steps	to	learn	how	to	build	the	most	effective	Visio	template	for	your	business:	Open	Visio	and	select	the	Flowchart	category,	and	select	Basic	Flowchart.	For	each	step	in	your	process,	select	and	drag	a	new	flowchart	shape	into
your	template.	Connect	flowchart	shapes	by	simply	holding	your	mouse	over	the	first	shape,	selecting	the	arrow	that	pops	up	after	a	few	seconds,	and	dragging	it	over	to	the	shape	you	want	to	connect	it	to.	Select	any	shape	and	click	inside	of	it	to	add	text	to	it	to	include	additional	information	not	evident	from	the	shapes	alone.	Continue	to	add	shapes
and	text	to	the	template	until	your	business	process	is	completely	explained	via	the	visual	Visio	workflow	template.	Empower	your	people	to	go	above	and	beyond	with	a	flexible	platform	designed	to	match	the	needs	of	your	team	—	and	adapt	as	those	needs	change.		The	Smartsheet	platform	makes	it	easy	to	plan,	capture,	manage,	and	report	on	work
from	anywhere,	helping	your	team	be	more	effective	and	get	more	done.	Report	on	key	metrics	and	get	real-time	visibility	into	work	as	it	happens	with	roll-up	reports,	dashboards,	and	automated	workflows	built	to	keep	your	team	connected	and	informed.		When	teams	have	clarity	into	the	work	getting	done,	there’s	no	telling	how	much	more	they	can
accomplish	in	the	same	amount	of	time.	Try	Smartsheet	for	free,	today.	Try	Smartsheet	for	Free	Get	a	Free	Smartsheet	Demo	Code	of	Conduct	GeneratorCompany	Profile	GeneratorCustomer	Profile	GeneratorJob	Description	GeneratorMeeting	Minutes	GeneratorOut	of	Office	Message	GeneratorPower	of	Attorney	GeneratorProduct	Requirements
Document	GeneratorRelease	of	Liability	Generator	May	13,	2025	A	flow	chart	is	a	powerful	visual	tool	used	to	illustrate	processes,	workflows,	or	systems	in	a	clear	and	logical	manner.	By	breaking	down	complex	tasks	into	simpler,	step-by-step	representations,	flow	charts	enhance	understanding	and	streamline	communication	across	diverse	teams	or
audiences.	These	diagrams	are	widely	utilized	in	business,	education,	engineering,	and	project	management	to	improve	efficiency	and	clarity.	Whether	you’re	mapping	out	a	decision-making	process,	troubleshooting	a	problem,	or	planning	a	project,	Lucidchart	templates	provide	a	versatile	and	professional	way	to	create	visually	appealing	flow	charts
that	save	time	and	improve	the	presentation	of	your	ideas.	Flow	Chart	Format	1.	Title	Clearly	state	the	purpose	or	process	being	represented.	2.	Start/End	Symbol	Oval	shapes	signify	the	beginning	and	end	of	the	process.	3.	Process	Steps	Rectangles	represent	individual	steps	or	actions	in	the	process.	4.	Decision	Points	Diamonds	indicate	decision-
making	steps	where	multiple	outcomes	are	possible.	5.	Arrows	Connectors	show	the	flow	or	direction	between	steps,	ensuring	logical	progression.	6.	Annotations	(Optional)	Additional	notes	or	comments	can	be	included	for	clarity.	40+	Flow	Chart	Templates	Word	Flowchart	Template	Free	Download	Google	Docs	MS	Word	Pages	Editable	PDF	Size:
A4,	US	Download	Now	Flow	Chart	Template	Google	Docs	MS	Word	Pages	Size:	A4,	US	Download	Now	Flow	Chart	Template	Word	Google	Docs	MS	Word	Pages	Size:	A4,	US	Download	Now	Workflow	Template	Word	Google	Docs	MS	Word	Pages	Size:	A4,	US	Download	Now	Microsoft	Office	Flowchart	Template	Google	Docs	MS	Word	Pages	Size:	A4,
US	Download	Now	Flowchart	PDF	Download	Google	Docs	MS	Word	Pages	Editable	PDF	Size:	A4,	US	Download	Now	Download	Flowchart	Template	MS	Excel	MS	Word	Numbers	Pages	Editable	PDF	Size:	A4,	US	Download	Now	Flowchart	Format	In	Word	Google	Docs	MS	Word	Pages	Editable	PDF	Size:	A4,	US	Download	Now	Simple	Flow	Chart
Template	Word	Google	Docs,	MS	Word,	Pages,	Editable	PDF	Size:	A4,	US	Download	Now	Flowchart	PDF	MS	Word	Google	Docs	Apple	Pages	PDF	Download	Now	Editable	Flowchart	Template	MS	Word	Google	Docs	Apple	Pages	PDF	Download	Now	Download	Flow	Chart	The	web	development	flow	chart	sample	shows	how	web	templates	work	to
create	both	static	webpages	in	advance	and	dynamic	webpages	on	demand.	It	shows	how	different	tools	work	together	to	create	a	customized	webpage	for	different	users.	You	can	also	see	more	on	Office	Flow	Charts.	Flowchart	Template	Free	The	Website	Flowchart	Template	sample	is	one	of	the	best	for	designing	websites.	The	flow	chart	provides
ample	insight	into	the	working	as	well	as	the	design	of	a	design	website.	It	is	a	great	tool	for	website	flowcharts.	Fillable	Flow	Chart	The	Retro	style	flowchart	samples	is	a	simple	flowchart	that	has	adopted	a	retro	style.	It	is	a	hand-drawn	illustration	with	space	provided	for	text.	The	turquoise	background	isolates	the	flowchart	giving	a	retro	look	to	it.
Blank	Flow	Chart	Template	The	lead	gen	flow	chart	sample	shows	how	a	lead	is	generated	for	a	particular	product	or	service	of	the	business	flyer.	It	can	be	used	to	show	lead	generation	by	advertising,	non-paid	sources	like	organic	search	engine	results,	or	referrals.	You	may	also	see	Business	Flow	Chart	Templates.	Downloadable	Flow	Chart	The
wireframe	flowchart	kit	is	an	easy-to-use	kit	for	adobe	illustrator.	It	creates	various	customizable	flowchart	elements	and	it	also	includes	some	mobile	wireframe	elements	to	work	with.	You	may	also	see	Audit	Flow	Chart	Templates.	Professional	Flowchart	Template	Creative	Flowchart	Template	Free	Sample	Smart	Home	Food	Flow	Chart	Template
Free	Easy	Web	Flow	Chart	Template	Free	App	Flow	Chart	for	Film	Ticket	Booking	Free	Organizational	Chart	EPS	Format	Template	Free	Teller	Data	Flowchart	Sample	Template	Size:	119.3	KB	Download	Now	If	you	have	showcase	teller	data	on	a	flowchart,	download	this	example	and	do	the	needful	quickly	and	easily.	The	sample,	as	you	can	see,	has
already	included	the	necessary	elements	to	make	the	modern	charts	have	a	complete	look.	Download	and	customize	further	if	you	need	to.	You	may	also	check	out	here	Flow	Chart	in	Pages.	Free	Sample	Flow	Chart	of	Harry	Potter	Church	Download	Now	In	class,	if	your	teacher	has	assigned	you	to	explain	the	Harry	Potter	series	on	a	flowchart,	this	is
the	sample	you	must	download.	You	wouldn’t	need	to	make	any	edits	or	changes	as	such,	the	flowchart	is	readymade	and	contains	all	the	necessary	information	in	the	way	it	should.	Still,	if	there	is	a	need	for	you	to	tweak	it	a	bit,	you	can.	You	may	also	see	Project	Flowchart	Templates.	Free	Basic	Flow	Chart	Template	in	PowerPoint	Size:	5.8	KB
Download	Now	Free	Decision	Tree	Flow	Chart	Template	Size:	20.3	KB	Download	Now	Free	Sample	of	Process	Flow	Chart	Free	Template	Size:	38.5	KB	Download	Now	This	is	yet	another	process-based	flowchart	examples.	Conveniently	explain	any	process–from	beginning	till	the	end–using	this	standard	template.	You	can	insert	relevant	information	in
the	boxes	provided	–	add	or	subtract	shapes,	symbols,	and	arrows	based	on	the	requirement.	Flowchart	Template	Excel	Size:	16.1	KB	Download	Now	A	flowchart	must	be	easy	to	follow.	Take	a	look	at	this	flowchart	sample.	It	has	got	a	simple	design	and	layout.	Even	if	you’re	a	beginner	and	you’re	dealing	with	flowcharts	for	the	first-timer,	with	this
general	template,	it	won’t	be	long	before	you	get	the	grasp	of	how	it	is	made.	You	may	also	see	Sales	Flow	Chart	Templates.	Free	Easy	Flow	Chart	PDF	Template	Size:	64	KB	Download	Now	Free	Sample	Flow	Chart	Template	Size:	8.8	KB	Download	Now	If	you’re	looking	for	more	options	for	the	simpler	kind	of	flowcharts,	this	mockup	simple	chart
belongs	to	the	category.	Explain	any	process	as	easily	as	possible	using	this	flowchart	sample.	It	is	free,	downloadable,	customizable,	and	fully	editable.	In	terms	of	looks,	it	is	an	elegant-looking	example.	You	may	also	see	Training	Flowchart	Templates.	Free	Swim	Lane	Flow	Chart	Template	Size:	144.3	KB	Download	Now	If	you	have	to	design	and
develop	a	swim	lane	flowchart,	don’t	sweat	it.	Download	this	example	instead	and	invest	time	in	inserting	the	necessary	information	in	the	boxes	given.	This	is	a	free	template,	however,	if	you	need	to	incorporate	it	in	a	PowerPoint	presentation,	you	can	do	that	too.	Free	Step	By	Step	Procedure	Flow	Chart	Excel	Format	Size:	21.2	KB	Download	Now
Free	New	Repair	Service	Swim	Lane	Flow	Chart	Size:	129.2	KB	Download	Now	Free	Sample	Quality	Control	Flow	Chart	Example	Size:	51.9	KB	Download	Now	lincolnshire.gov.uk	Size:	11.3	KB	Download	Now	Manufacturing	Process	Flow	Chart	Template	eduplace.com	Size:	8	KB	Download	Now	Free	Process	Flow	Diagram	Chart	Template	prisma-
statement.org	Size:	300.7	KB	Download	Now	Free	School	Work	Flow	Chart	Template	functionalresonance.com	Size:	2.9	MB	Download	Now	Free	Example	of	Business	Planning	Flow	Chart	liv.asn.au	Size:	77.1	KB	Download	Now	Free	Simple	Project	Process	Flow	Chart	Template	propelpmc.com	Size:	135.6	KB	Download	Now	Free	Flow	Chart	Symbols
Template	breezetree.com	Size:	48.3	KB	Download	Now	Flow	Chart	Template	Best	Way	to	Make	a	Flowchart	in	Word	Flowcharts	are	one	of	the	best	tools	to	explain	a	process	in	a	systematic	yet	easy-to-understand	manner.	There	are	several	ways	to	design	a	flowchart	like	using	Communication	Flow	Chart	Templates.	However,	some	people	prefer
using	MS	Word.	Here	is	how	you	can	design	a	flowchart	in	MS	Word.	Maximize	the	page	and	collapse	the	ribbons	using	CTRL+F1	so	that	you	can	only	see	the	menu	tabs.	Select	View	and	click	on	the	option	Grid-lines.	This	will	display	grids	on	the	page,	thus	making	it	easier	for	you	to	align	the	flowchart.	Next	click	on	Insert	and	select	shapes.	Here
you	will	find	specific	shapes	that	are	used	for	flowcharts.	Go	ahead	and	select	the	first	shape	which	will	be	oblong	for	“Start”.	Select	the	shape	and	your	cursor	will	transform	to	a	plus	sign.	With	the	left	mouse	button	pressed,	drag	the	mouse	to	get	the	desired	shape	in	the	required	size.	Now	click	inside	the	shape	and	add	the	label.	You	can	add
arrows	for	the	flowchart	using	the	Lines	option	under	Shapes.	Go	on	inserting	the	desired	shapes	and	arrows	to	design	a	perfect	flowchart.	Types	of	Flowcharts	Flowcharts	come	in	various	forms,	each	tailored	to	specific	needs	and	applications.	Here	are	the	key	types	of	flowcharts:	1.	Process	Flowchart	This	is	the	most	common	type	of	flowchart	used
to	map	out	processes,	illustrating	steps	and	decision	points	for	improved	understanding	and	efficiency.	2.	Data	Flowchart	Used	in	system	design	and	analysis,	this	flowchart	visually	represents	the	flow	of	data	within	a	system,	helping	to	identify	inputs,	outputs,	and	storage	points.	3.	Workflow	Flowchart	Ideal	for	project	management	and	team
collaboration,	this	flowchart	maps	workflows,	highlighting	roles,	responsibilities,	and	the	sequence	of	tasks.	4.	Swimlane	Flowchart	This	type	organizes	processes	into	lanes	representing	different	departments	or	individuals,	clarifying	roles	and	improving	accountability.	5.	Decision	Flowchart	Focused	on	decision-making	processes,	this	type	illustrates
different	outcomes	based	on	specific	choices	or	conditions.	6.	System	Flowchart	Common	in	software	engineering,	it	maps	out	the	interactions	between	system	components,	helping	to	understand	system	architecture	and	workflows.	How	to	Make	a	Flowchart	in	Excel?	Using	Software	Flowchart	Templates	is	a	great	way	to	simplify	the	process	of
flowchart	creation.	However,	you	can	also	use	MS	Excel	to	design	flowcharts.	Here	is	how	to	design	a	flow	Chart	in	Excel.	Open	a	blank	workbook.	You	need	to	first	design	a	grid	that	will	help	you	align	the	flowchart	properly.	Select	all	the	cells	by	clicking	on	the	top	left-hand	side	of	the	sheet.	Now,	right-click	on	any	column	and	specify	a	column
width.	This	will	transform	the	sheet	into	uniform	grids	for	the	flowchart	canvas.	Next,	click	on	the	Insert	tab	and	select	the	option	SmartArt	or	Shapes,	whatever	you	prefer.	Select	the	object	and	then	draw	it	on	the	sample	sheet.	You	can	also	add	arrows	for	the	flowchart	using	these.	Continue	doing	this	till	you	have	completed	the	flowchart.	You	can
label	each	shape	by	clicking	inside	it.	Designing	flowcharts	is	a	great	way	to	define	a	particular	processor	to	explain	the	workflow	chart	to	the	team	and	the	higher	officials.	However,	people	who	have	to	do	this	day	in	and	day	out	can	surely	save	a	lot	of	time	by	using	Sports	Flowchart	Templates.	These	can	be	customized	as	per	their	needs	and	would
help	them	save	a	lot	of	time.	You	can	also	see	more	on	Management	Flow	Charts.	How	to	Create	a	Flowchart	Creating	a	flowchart	involves	following	a	series	of	structured	steps	to	ensure	clarity	and	effectiveness.	Below	is	a	step-by-step	guide	to	help	you	create	a	flowchart:	1.	Identify	the	Purpose	Determine	the	specific	process	or	workflow	you	want
to	visualize.	Clearly	define	the	start	and	end	points	to	maintain	focus	and	structure.	2.	Gather	Information	Collect	all	necessary	details	about	the	process,	including	the	sequence	of	tasks,	decision	points,	and	participants	involved.	3.	Choose	a	Tool	Select	a	tool	for	creating	your	flowchart.	You	can	use	software	like	Microsoft	PowerPoint,	Visio,
Lucidchart,	or	online	platforms	that	provide	user-friendly	templates.	4.	Use	Standard	Flowchart	Symbols	Incorporate	standard	flowchart	symbols	such	as:	Ovals	for	start	and	end	points	Rectangles	for	process	steps	Diamonds	for	decision	points	Arrows	to	show	the	flow	of	steps	5.	Arrange	Steps	Sequentially	Organize	the	steps	logically	from	start	to
finish,	ensuring	each	task	or	decision	is	clearly	represented	and	connected.	6.	Add	Annotations	(Optional)	Include	brief	notes	or	comments	if	additional	context	is	needed	for	specific	steps.	7.	Review	and	Test	Examine	the	flowchart	to	ensure	it	accurately	represents	the	process.	Test	it	with	others	for	feedback	and	clarity.	8.	Finalize	and	Share	Polish
the	flowchart	by	checking	for	consistency	in	design	and	formatting.	Share	it	with	the	intended	audience	or	team	for	implementation.	Tips	to	Remember	When	Creating	a	Flowchart	1.	Keep	It	Simple	Focus	on	the	key	steps	and	avoid	overloading	the	flowchart	with	unnecessary	details	to	maintain	clarity.	2.	Use	Consistent	Symbols	Stick	to	standard
flowchart	symbols	throughout	to	ensure	the	diagram	is	easy	to	understand.	3.	Maintain	Logical	Flow	Arrange	steps	sequentially	and	use	arrows	to	clearly	indicate	the	direction	of	the	process.	4.	Limit	Crossovers	Minimize	intersecting	lines	and	connectors	to	keep	the	flowchart	visually	clean	and	organized.	5.	Add	Descriptive	Labels	Label	all	steps	and
decision	points	clearly	to	provide	enough	context	for	understanding	at	a	glance.	FAQs	Yes,	Microsoft	Word	provides	built-in	tools	to	create	flowcharts.	You	can	use	the	“Shapes”	option	under	the	“Insert”	tab	to	add	flowchart	symbols	and	connectors.	Yes,	Excel	offers	flowchart	templates	and	tools	to	create	customized	flowcharts.	You	can	use	pre-
designed	templates	or	create	one	using	shapes	and	connectors	under	the	“Insert”	tab.	Oval	–	Represents	start	or	end	points.	Rectangle	–	Denotes	a	process	or	action	step.	Diamond	–	Indicates	a	decision	point.	Arrow	–	Shows	the	flow	or	direction.	Parallelogram	–	Represents	input	or	output.	Circle	–	Used	as	a	connector	to	link	parts	of	the	flowchart.
Hexagon	–	Represents	preparation	or	initialization.	WORKFLOW	Workflow	Automation	Unlock	creativity,	enhance	efficiency,	and	foster	innovation	with	Idea	Management	Software.	Streamline	idea	vetting,	procedure	development,	and	feedback	processes	for	employees,	customers,	and	partners.	Stay	competitive	and	relevant	by	implementing	a
platform	that	cultivates	a	culture	of	innovation.	Boost	organizational	innovation	effortlessly	with	Integrify's	Idea	Management	App.	Managers,	system	analysts,	programmers,	and	engineers	adopted	flowcharts	as	a	mean	of	communication	for	describing:	Document	workflows	Data	flows	System	operation	flows	Algorithms	No	wonder	that	building
blocks	and	rules	of	flow	charts	were	standardized	by	the	American	National	Standards	Institute	(ANSI)	and	International	Organization	for	Standards	(ISO)	more	than	50	years	ago.	The	current	standard	defines	the	drawing	direction	from	top	to	bottom	and	left	to	right	and	specific	symbols	for	different	types	of	entities,	actions,	etc.	E.g.:	Rectangle	with
round	corners	marks	for	starting	and	terminating	states	Box	with	straight	corners	represents	the	process	stages	Parallelogram	illustrates	data	input/output	Diamond	marks	conditional	branching	Arrow	shows	the	process	flow	You	can	find	all	these	shapes	and	other	useful	visual	elements	in	the	Shapes	dropdown	list	on	the	Insert	tab	of	Microsoft
Word.	The	flowchart	above	is	"cross-functional"	and	defines	the	responsibility	zones	of	different	business	units.	To	create	a	diagram	like	the	one	above,	follow	the	next	steps	(we	recommend	to	check	the	tip	how	to	easily	organize	shapes	in	Word,	which	demonstrates	easy	tricks	to	simplify	the	drawing	routine):	Add	the	drawing	canvas	The	drawing
canvas	is	an	essential	element	for	the	flow	chart	that	you	need	to	add	before	adding	the	flow	shapes	because	of	flowchart	connectors.	You	can	add	flowcharts	connectors	only	between	the	shapes	within	the	drawing	canvas:				1.			On	the	Insert	tab,	in	the	Illustrations	group,	click	Shapes:				2.			On	the	Shapes	list,	in	the	bottom,	choose	New	Drawing
Canvas:	Word	adds	the	new	drawing	canvas	to	your	flow	chart:	Draw	the	flowchart	blocks				3.			On	the	Shapes	list,	in	the	Flowchart	group,	select	the	block	you	want	to	add:				4.			To	add	text	to	the	selected	shape,	just	double-click	in	it	and	enter	the	text.	Connect	the	flowchart	blocks	by	connectors				5.			To	connect	shapes,	do	the	following:	On	the
Insert	tab,	in	the	Illustrations	group,	click	in	the	Shapes	list	and	then	select	one	of	the	connectors	in	the	Lines	group:	Select	the	beginning	point	on	the	border	of	the	first	shape	(source)	and	the	ending	point	on	the	edge	of	the	second	shape	(target):	For	more	customizations	of	shapes	and	connectors,	see	how	to	change	format	of	diagram	shapes	in
Word	and	how	to	change	flowchart	shapes	or	how	to	change	connector	type	for	flowchart.	Top-to-down	flowcharts	are	perfect	for	the	Portrait	page	orientation	in	Microsoft	word.	For	the	Landscape	page	orientation	or	the	PowerPoint	presentation,	the	preferred	layout	is	left-to-right.	Sometimes	left-to-right	flow	diagrams	with	delimited	borders	of
organization	unit	activities	are	called	Swimlane	diagrams	or	Swimlane	flowcharts.	See	also	this	tip	in	French:	Comment	créer	un	organigramme	des	opérations	dans	Word.	Today,	30%	of	our	visitors	use	Ad-Block	to	block	ads.We	understand	your	pain	with	ads,	but	without	ads,	we	won't	be	able	to	provide	you	with	free	content	soon.	If	you	need	our
content	for	work	or	study,	please	support	our	efforts	and	disable	AdBlock	for	our	site.	As	you	will	see,	we	have	a	lot	of	helpful	information	to	share.	A	diagram	is	worth	a	thousand	words,	especially	if	you’re	trying	to	explain	a	process.	And	if	you	know	how	to	make	a	flowchart	in	Word,	you	don’t	need	a	different	diagram-creation	tool.By	Allie
Riggs		|		Updated	January	22,	2025You	can	make	a	flowchart	right	inside	Microsoft	Word,	no	programming	or	design	skills	required.	Keep	reading	to	learn	what	you	need	to	know	about	how	to	create	a	flowchart	diagram	in	Word.	A	flowchart	is	a	graphical	representation	of	a	series	of	steps	or	actions.	It’s	most	effective	for	depicting	a	process,	data
flow,	workflow,	or	decision	steps.	In	a	flowchart,	each	shape	holds	a	meaning.	The	most	basic	ones	are:	Oval	(or	pill	shape).	Start	or	end	of	the	process.	Rectangle.	Action	or	sub-process.	Diamond.	Decision	point.	Parallelogram.	Either	an	input	needed	for	the	process	or	an	output	that	goes	into	the	next	step.	Other	shapes	are	used	in	flowcharts	for	very
specific	applications,	like	data	flow	diagrams,	but	these	basic	flowchart	symbols	should	be	enough	for	the	most	common	charts.	Whether	you	need	just	the	basics	or	specialized	shapes,	you	can	find	them	in	Word.	In	this	tutorial,	I’ll	walk	you	step	by	step	through	how	to	make	flow	charts	in	Microsoft	Word	using	basic	shapes.	Word	offers	two	ways	to
create	a	flowchart.	Use	the	method	that	lets	you	make	the	flowchart	you	envision.	Note:	For	this	tutorial,	I	used	Microsoft	Word	for	Mac	version	16.	If	you’re	using	a	different	version	of	the	application,	the	interface	and	steps	may	be	different.	The	first	way	to	create	a	flowchart	in	Word	is	by	inserting	shapes	in	your	document.	Here’s	what	to	do:
Before	getting	started,	make	sure	to	switch	on	gridlines.	This	will	make	it	much	easier	for	you	to	create	a	nice-looking	flowchart.	When	gridlines	are	on,	shapes	and	lines	snap	to	regular	spaces,	making	it	easy	to	align	elements.	To	switch	on	the	gridlines,	go	to	View	>	Gridlines.	Now	you’re	ready	to	start	inserting	shapes.	Go	to	Insert	>	Shapes.	The
shape	menu	appears.	Scroll	down	to	the	Flowchart	shapes.	If	you	hover	over	any	shape,	a	tooltip	appears,	letting	you	know	what	the	shape	means.	Click	on	the	shape	you	wish	to	use.	The	cursor	turns	into	a	crosshair.	Click	and	drag	the	crosshair	to	create	the	shape	to	the	size	you	want.	Use	the	options	on	the	Shape	Format	ribbon	to	format	the
shape’s	fill	color,	border,	and	other	attributes.	To	add	text	inside	a	flowchart	shape,	first	select	the	shape.	Then,	start	typing.	The	text	will	appear	inside	the	selected	shape.	If	you	wish	to	format	the	text	inside	a	shape,	select	the	shape.	Under	the	Home	tab,	use	the	formatting	options	to	select	the	font,	font	size,	and	other	attributes.	To	ensure	the
security	and	originality	of	your	document,	it’s	also	important	to	know	how	to	add	a	watermark	in	Word.	Repeat	the	previous	steps	to	create	all	the	shapes	you	need	for	your	flowchart.	Use	the	gridlines	to	arrange	them	on	your	document.	Next,	you’re	going	to	want	to	connect	the	shapes	with	lines	or	arrows.	To	insert	an	arrow,	go	to	Insert	>	Shapes	>
Lines.	The	line	menu	opens.	Click	on	the	line	you	wish	to	use.	Under	the	Shape	Format	tab,	use	the	options	to	format	the	connector.	When	the	line	is	formatted	as	you	like,	set	it	as	a	default	line.	That	way,	Word	will	use	the	same	formatting	settings	for	the	next	lines	you	create,	and	you	won’t	have	to	keep	formatting	each	one.	To	set	a	line	as	the
default	line,	right-click	on	it,	and	then	select	Set	as	Default	Line.	Repeat	the	process	until	you’ve	inserted,	formatted,	and	arranged	all	the	connectors	you	need.	You	may	find	that	you	need	text	outside	of	the	shapes	in	your	flowchart.	To	add	text,	go	to	Insert	>	Text	Box.	Click	and	drag	the	cursor	where	you	want	to	place	the	text	box.	Type	the	text
inside	the	box.	Next,	format	the	text.	With	the	text	box	selected,	click	on	the	Home	tab.	Use	the	formatting	options	on	the	ribbon	to	format	the	text.	When	your	flowchart	is	complete,	switch	off	the	Gridlines,	and	enjoy	your	creation!	Another	way	to	create	flowcharts	in	MS	Word	is	by	using	SmartArt.	It’s	a	pre-designed	visual	template	in	Word	that	lets
you	quickly	make	charts	and	diagrams.	You	can	format	SmartArt—up	to	a	certain	extent—and	personalize	it	with	your	own	information.	To	create	a	Microsoft	SmartArt	flowchart,	follow	these	steps:	Go	to	Insert	>	SmartArt	>	Process.	Click	the	down	arrow.	The	Process	menu	pops	up	with	all	the	process	graphic	options.	Choose	the	SmartArt	that’s
most	suitable	for	the	flowchart	you	wish	to	create.	Under	the	SmartArt	Design	tab,	use	the	tools	on	the	ribbon	to	format	the	various	elements	of	the	SmartArt.	Explore	the	special	effects	menu	to	see	ways	you	can	spice	up	your	chart.	At	any	point,	you	can	also	change	the	style	of	your	Microsoft	SmartArt	flowchart.	First,	select	SmartArt.	Under	the
SmartArt	Design	tab,	open	the	styles	menu.	Click	on	a	different	style	you	wish	to	apply.	You’ll	probably	need	to	add	steps	to	your	process	SmartArt.	To	do	this,	make	sure	you’re	on	the	SmartArt	Design	tab.	Click	on	the	Add	Shape	drop-down	menu	and	choose	from	one	of	two	options:	Add	Shape	After.	Adds	a	step	at	the	end	of	the	current	SmartArt.
Add	Shape	Before.	Adds	a	step	at	the	beginning.	You	can	add	steps	at	any	point	in	your	workflow.	But	I	suggest	you	add	all	the	steps	you	think	you’ll	need	before	you	add	your	text.	To	add	your	text,	click	on	a	text	box—it’ll	have	a	placeholder	that	says	“Text”—and	type	your	own	text.	Under	the	SmartArt	Design	tab,	you	can	also	click	on	the	Text	Pane
button	to	add	and	edit	text	through	the	SmartArt	Text	pane.	You	can	also	format	the	text	inside	the	SmartArt.	First,	select	the	text	box,	and	then	click	on	the	Home	tab.	Use	the	formatting	options	to	change	the	font,	font	size,	and	so	on.	If	the	SmartArt	flowchart	style	you	created	includes	pictures,	now’s	the	time	to	add	your	custom	images.	Click	on
the	image	icon.	This	launches	your	document	finder.	Click	on	the	image	file	you	want	to	add,	and	then	click	Insert.	Make	sure	your	image	has	the	correct	proportions	for	the	image	placeholder	in	the	SmartArt.	If	the	placeholder	is	square,	edit	your	image	to	be	a	square	before	inserting	it.	Otherwise,	it	may	get	cropped	awkwardly.	Repeat	the	steps
above	to	complete	your	Microsoft	SmartArt	flowchart.	Now	that	know	how	to	create	a	flowchart	diagram	in	Word	using	two	methods,	you	may	be	wondering	which	is	the	better	way:	Shapes	or	SmartArt?	Each	has	its	advantages	and	disadvantages.	Use	Flowchart	Shapes	to	create	a	flowchart	if:	You	want	complete	control	over	how	your	flowchart
looks.	It’s	simply	easier	to	control	the	different	elements	of	a	flowchart	that’s	built	from	scratch	using	shapes	and	lines	or	arrows	as	connectors.	You	want	to	use	symbolic	flowchart	shapes.	Word	shapes	include	both	the	basic	shapes	and	special	flowchart	shapes.	You’ve	got	a	complicated	flowchart.	If	you’re	trying	to	create	a	flowchart	with	split	steps
(like	the	bread-making	flowchart	I	made),	then	you’re	better	off	using	shapes.	Consider	using	SmartArt	to	make	a	flowchart	if:	You	want	a	creatively	designed	chart	quickly.	SmartArt	process	diagrams	are	made	by	designers	to	look	great	with	minimal	fuss.	You	don’t	need	traditional	flowchart	shapes.	Most	Microsoft	SmartArt	flowcharts	use	only	basic
shapes	and	other	elements	that	are	chosen	more	for	aesthetic	purposes.	Your	flowchart	has	only	a	few	simple	steps.	SmartArt	charts	lend	themselves	best	to	straightforward	processes.	Microsoft	Word	gives	you	two	convenient	ways	to	make	MS	Word	flowchart	diagrams.	To	get	the	best	results,	keep	these	tips	in	mind:	Scheme	is	a	graphic	template
that	can	be	edited	in	Sketch.	Have	a	clear	vision	of	what	you	want	your	flowchart	to	look	like.	Sketch	it	out	with	pen	and	paper,	and	know	exactly	what	text	and	images	you’re	going	to	use.	Use	a	consistent	style	among	the	shapes	and	connectors	in	your	flowchart.	For	example,	use	just	one	or	two	fonts	for	the	text.	For	the	greatest	legibility,	make	sure
your	chart	fits	all	on	one	page.	You	may	have	to	change	the	document’s	orientation	from	portrait	to	landscape	to	accommodate	a	long	or	wide	flowchart.	Simple	Flows	is	a	flowchart	template	that	can	be	edited	in	Adobe	XD	and	Figma.	As	mentioned	above,	shapes	have	specific	meanings	when	used	in	flowcharts,	but	your	readers	may	not	know	what
those	are.	Make	sure	your	flowchart	makes	sense	even	if	this	is	the	case.	It’s	also	a	good	idea	to	include	a	legend	or	symbol	key	to	let	your	readers	know	what	the	various	shapes	stand	for.	In	the	English	language,	readers	read	from	left	to	right	and	top	to	bottom.	If	your	flowchart	is	more	than	one	level	long,	continue	the	second	level	on	the	left	side	of
the	page.	(Of	course,	if	your	document	is	in	a	language	that’s	read	from	right	to	left,	bottom	to	top,	then	you’d	follow	that	direction	for	your	flowchart	as	well.)	Flowchart	Infographics	can	be	edited	in	Adobe	Photoshop	and	Adobe	Illustrator.	After	creating	a	flow	chart	diagram	in	Word,	walk	through	the	flowchart	with	the	people	involved.	They’ll	know
how	long	their	jobs	take.	They’ll	also	be	able	to	tell	you	how	accurate	it	is.	If	the	flowchart	is	for	a	process	that	isn’t	in	place	yet,	try	getting	coworkers	to	simulate	the	process	with	you.	When	making	your	Microsoft	Word	flowchart	template,	avoid	overlapping	connection	arrows.	When	lines	cross	over	each	other,	it’s	difficult	to	tell	where	that	line
connects.	The	reader	may	also	interpret	the	two	lines	as	a	point	with	two	possible	routes,	which	may	not	be	what	you	intended.	If	you’ve	got	to	cross	lines,	add	a	crossover	bump	to	show	that	one	connector	arrow	is	jumping	over	the	other	arrow.	Consider	creating	a	flowchart	symbol	key	when	creating	a	flow	chart	in	Word.	Some	people	may	not	be
familiar	with	what	all	the	shapes	and	symbols	mean.	If	you	provide	a	key,	it’ll	help	avoid	confusion.	Set	02	Flowcharts	Infographics	can	be	edited	in	Adobe	Illustrator	and	Adobe	Photoshop.	When	making	your	Microsoft	Word	flowchart,	do	not	use	all	caps.	All	caps	take	up	space,	which	can	make	designing	a	neat-looking	flowchart	difficult.	All	caps	are
also	harder	to	read	than	lowercase	letters.	You	can	color	code	the	steps	in	flowcharts	in	Word	to	identify	resources.	If	you	do	add	color-coded	steps,	make	sure	to	add	the	colors	to	your	key.	It’s	common	to	see	colorful	flowcharts	for	aesthetic	purposes.	Another	way	to	streamline	your	workflow	is	with	a	Word	template.	Templates	may	include	a
Microsoft	Word	flowchart	or	other	diagrams.	Even	if	that’s	not	the	case,	starting	with	a	Microsoft	Word	flowchart	template	is	still	an	easy	way	to	create	a	professionally	designed	document.	With	a	template	for	Word,	all	the	major	design	decisions	have	already	been	made	for	you	by	a	professional.	All	you’ve	got	to	do	is	to	customize	it	with	your
branding	colors,	images,	and	text.	Word	templates	from	Envato	Elements	streamline	your	work	process.	One	excellent	source	of	Word	templates	is	Envato	Elements.	In	this	creative	marketplace,	you’ll	find	templates	for	various	kinds	of	documents	such	as	this	resume/CV	template,	which	includes	infographics.	You’ll	find	thousands	of	MS	Word
templates	in	Envato	Elements.	An	Elements	subscription	gives	you	access	to	much	more	than	high-quality	Word	templates.	For	one	low	fixed	price	per	month,	you	get	unlimited	downloads	of	the	creative	components	you	need	to	make	your	document	look	its	best,	such	as	fonts,	photos,	graphics,	and	icons.	And	if	you	create	other	types	of	materials,	like
videos	and	websites,	then	you’ll	also	benefit	from	unlimited	downloads	of	stock	videos,	music,	sound	effects,	and	presentation	templates.	Now	you	know	how	to	make	an	easy	flowchart	in	Microsoft	Word.	For	complete	control,	build	your	flowchart	with	shapes	and	lines.	For	a	fast	and	artistic	look,	use	SmartArt.	Either	way,	a	well-constructed	flowchart
will	make	your	document	more	effective	at	showing	a	process,	workflow,	or	data	flow.	You	can	also	use	Word	templates	to	streamline	your	workflow.	For	the	best	quality	and	value,	get	Word	templates	and	other	creative	resources	from	Envato	Elements.	Your	subscription	brings	to	your	fingertips	millions	of	creative	assets	to	help	you	communicate
effectively.	Wondering	how	to	create	a	flowchart	in	Word?	Microsoft	Word	provides	versatile	tools,	such	as	SmartArt	for	flowcharts	and	customizable	shapes	for	flowchart	creation,	to	design	workflows	and	visualize	ideas	effectively.	From	illustrating	organizational	processes	to	creating	project	timelines,	Word	is	a	convenient	tool	for	crafting
professional-looking	flowcharts.	By	combining	its	Microsoft	Office	flowchart	tools,	you	can	design	workflows	that	align	with	your	specific	needs.This	guide	will	walk	you	through	Microsoft	Word	flowchart	tutorials,	exploring	two	popular	methods:	using	shapes	and	SmartArt.	Additionally,	we’ll	share	tips	for	advanced	customization	and	compare	these
tools	to	help	you	decide	the	best	approach.How	to	Create	a	Flowchart	in	Word	(Using	2	Methods)This	Microsoft	Word	flowchart	tutorial	will	guide	you	through	two	easy	methods	to	create	flowcharts	in	Word:Method	1:	Using	Shapes	for	Flowchart	CreationTo	know	how	to	build	a	flowchart	in	Word	follow	the	steps	given	below:Step	1:	Open	a	Blank
DocumentLaunch	Microsoft	Word	and	open	a	new	blank	document	to	start	your	flowchart.Open	a	Blank	DocumentStep	2:	Access	the	Shapes	ToolGo	to	the	Insert	tab	and	click	Shapes.	A	menu	will	appear	with	various	shapes	that	are	commonly	used	in	flowcharts,	such	as	rectangles,	diamonds,	and	arrows.Access	the	Shapes	ToolStep	3:	Draw	Your
Flowchart	ShapesChoose	a	shape	(e.g.,	rectangle	for	processes,	diamond	for	decisions)	and	click	and	drag	on	the	page	to	create	it.	Add	more	shapes	as	needed	to	represent	each	step.Draw	Your	Flowchart	ShapesStep	4:	Connect	the	ShapesReturn	to	the	Shapes	menu	and	select	a	line	or	arrow.	Draw	connectors	between	the	shapes	to	show	the	flow	of
the	process.Connect	the	ShapesStep	5:	Add	Text	to	the	ShapesClick	on	each	shape	and	type	the	relevant	text	or	description	of	the	process.	You	can	adjust	the	font	size,	style,	and	alignment	using	the	toolbar.Add	Text	to	the	ShapesStep	6:	Customize	the	Flowchart	DesignUse	the	Format	tab	to	change	the	color,	border,	and	style	of	shapes	and
connectors,	making	your	flowchart	visually	appealing.Customize	the	Flowchart	DesignOnce	your	flowchart	is	complete,	save	the	document	by	clicking	File	>	Save	As.	You	can	also	export	it	as	a	PDF	or	print	it	for	presentations	or	distribution.Save	and	ShareIf	you're	using	Word	2013	or	earlier,	the	process	remains	the	same,	but	the	Shapes	tool	and
formatting	options	may	appear	slightly	different.	However,	the	basic	functionality	of	creating	a	flowchart	is	still	available.Method	2:	Using	SmartArt	for	FlowchartsTo	know	how	to	build	a	flowchart	in	word	using	Smart	Art	follow	the	steps	given	below:Step	1:	Open	a	Blank	DocumentLaunch	Microsoft	Word	and	create	a	new	blank	document	where	you
want	to	insert	your	flowchart.Open	a	Blank	DocumentStep	2:	Go	to	the	Insert	Tab	and	Choose	SmartArtClick	on	the	Insert	tab	in	the	ribbon	at	the	top	of	the	screen.	In	the	Illustrations	section,	click	on	SmartArt.	This	opens	the	Choose	a	SmartArt	Graphic	dialog	box.Go	to	the	Insert	Tab	>>	Choose	SmartArtStep	3:	Select	a	Flowchart	LayoutIn	the
dialog	box,	select	Process	from	the	list	on	the	left.	Choose	a	flowchart	design	(such	as	Basic	Process	or	Process	Arrows)	that	best	suits	your	needs.	Click	OK	to	insert	it	into	the	document.Select	a	Flowchart	LayoutStep	4:	Add	Text	to	Each	ShapeClick	on	each	shape	within	the	flowchart	and	type	the	relevant	text,	such	as	steps,	processes,	or
decisions.Add	Text	to	Each	ShapeStep	5:	Customize	the	FlowchartUse	the	SmartArt	Tools	on	the	ribbon	to	customize	the	design.	Under	the	Design	tab,	you	can	change	the	layout,	colors,	and	styles	to	better	match	your	needs.	You	can	also	resize	and	reposition	the	shapes	for	better	organization.Customize	the	FlowchartOnce	your	flowchart	is
complete,	save	the	document	by	selecting	File	>	Save	As.	You	can	also	export	it	as	a	PDF	or	print	it	for	presentations	or	meetings.Save	and	ShareAdvanced	Customization	TipsMake	your	flowcharts	stand	out	with	these	Microsoft	Office	flowchart	tools	and	advanced	tips:1.	Aligning	Shapes	AutomaticallyUse	the	Align	option	to	neatly	position
shapes.Select	multiple	shapes,	go	to	the	Shape	Format	tab,	and	choose	Align	to	align	shapes	horizontally,	vertically,	or	distribute	them	evenly.2.	Adding	Gridlines	for	PrecisionEnable	gridlines	to	ensure	precise	placement	of	shapes:Go	to	View	tab	and	check	Gridlines.Snap	shapes	to	the	grid	for	consistent	alignment	and	spacing.3.	Using	Colors	and
Styles	to	Improve	ReadabilityApply	consistent	colors	and	styles	for	clarity:Use	the	Shape	Format	tab	to	select	predefined	styles	or	create	custom	fills,	outlines,	and	effects.Choose	contrasting	colors	for	better	visibility	and	group	related	shapes	with	the	same	color.These	advanced	tips	ensure	your	shapes	and	designs	are	both	professional	and	easy	to
interpret.Comparison:	Shapes	vs.	SmartArt	in	Microsoft	WordFeatureShapesSmartArtPurposeBasic	drawings	and	custom	visuals.Pre-designed	templates	for	structured	visuals.Ease	of	UseRequires	manual	arrangement	and	formatting.Easy	to	use	with	built-in	layouts.CustomizationFully	customizable;	each	shape	is	independent.Limited	customization
within	predefined	designs.Best	ForSimple	diagrams,	flowcharts,	or	annotations.Organizational	charts,	process	flows,	and	hierarchies.FlexibilityHigh	flexibility	for	unique	designs.Ideal	for	structured	and	standardized	visuals.AutomationNo	automatic	alignment	or	hierarchy.Automatically	aligns	and	organizes	content.ExamplesArrows,	rectangles,
circles.Org	charts,	process	diagrams,	cycle	charts.Conclusion	With	Microsoft	Word’s	flowchart	tools,	creating	professional	workflows	and	process	diagrams	becomes	simple	and	effective.	Whether	you	choose	to	use	SmartArt	for	flowcharts	for	quick	templates	or	prefer	the	detailed	customization	of	shapes	for	flowchart	creation,	Word	has	the	flexibility
to	meet	your	needs.	Explore	these	features	to	elevate	your	designing	workflows	in	Word	and	bring	clarity	to	your	ideas	and	presentations.	Microsoft	Word	provides	built-in	tools	for	creating	and	arranging	different	types	of	flowcharts.	You	can	create	your	own	flowchart	by	using	different	shapes	and	SmartArt.	Here’s	how	to	do	it.	Making	a	Flowchart
in	Word	When	working	with	shapes	in	any	Office	application,	it’s	always	useful	to	use	gridlines	to	make	sure	everything	is	sized	and	placed	correctly.	To	make	the	gridlines	appears,	head	over	to	the	“View”	tab	and	tick	the	"Gridlines"	checkbox.	Your	gridlines	will	now	appear	on	your	Word	document.	Next,	switch	to	the	"Insert"	tab	and	then	click	the
“Shapes”	button	(we’ll	go	through	SmartArt	later).	A	drop-down	menu	displays	a	large	library	of	shapes	you	can	choose	from.	We’ll	be	focusing	on	two	things	here—the	connectors	in	the	“Lines”	group	near	the	top	and	the	shapes	in	the	“Flowchart”	group	near	the	bottom.	Before	we	continue,	it’s	important	to	understand	the	intended	purpose	of	the
shapes.	You	may	want	to	consider	reading	this	comprehensive	list	that	details	the	meaning	of	flowchart	shapes,	but	here’s	a	quick	overview	of	the	basics.	Rectangle:	Used	for	process	steps.	Diamond:	Used	to	show	decision	points.	Oval:	Used	as	the	terminator	shape,	indicating	the	start	and	end	points	of	a	process.	Hovering	over	any	of	the	shapes	in
the	drop-down	menu	displays	a	text	bubble	showing	the	shape's	purpose.	Let’s	go	ahead	and	insert	our	first	shape.	Back	at	the	shapes	menu,	select	the	shape	you’d	like	to	use	in	the	flow	chart.	Since	this	is	our	first	shape	being	used	in	the	flowchart,	we’ll	use	the	oval	shape.	Once	you	select	the	shape,	you’ll	notice	your	cursor	turns	into	a	crosshair.	To
draw	the	shape,	click	and	drag.	After	drawing	the	shape,	you’ll	notice	a	new	“Format”	tab	appears	with	commands	that	let	you	format	your	shape,	change	the	outline	and	fill	color,	and	more.	To	insert	text	inside	the	shape,	select	the	shape	and	then	start	typing.	Let’s	insert	another	shape	and	then	connect	the	two	shapes.	We’ll	add	a	rectangle	to
indicate	another	part	of	the	process.	Repeat	the	above	steps	to	insert	the	shape.	To	connect	the	two	shapes,	head	back	to	the	shape	menu	and	select	the	connector	you	want	to	use.	We’ll	use	a	simple	line	arrow	for	this	example.	Once	you	select	the	arrow,	click	the	center	handle	on	the	first	shape	and	then,	while	still	holding	down	your	mouse	button,
drag	to	the	center	handle	on	the	next	shape.	As	with	shapes,	you	can	also	format	the	arrow	with	different	line	widths,	colors,	and	so	on.	If	you	plan	to	use	the	same	line	format	throughout	the	entire	flowchart,	right-click	the	inserted	line	after	you’ve	formatted	it	and	select	“Set	as	Default	Line.”	You	can	do	this	with	shapes,	too.	In	addition	to	using
shapes	to	create	your	flowchart,	you	also	have	some	pretty	handy	options	with	SmartArt.	Head	over	to	the	“Insert”	tab	and	then	click	the	“SmartArt”	button.	In	the	Choose	a	SmartArt	Graphic	window,	select	the	“Process”	category	on	the	left,	chose	a	type	of	process	(we're	using	the	“Picture	Accent	Process”	option	here),	and	then	click	“OK.”	This
SmartArt	graphic	is	designed	explicitly	to	detail	a	process.	It	groups	shapes	for	adding	photos	(1)	and	text	(2).	Enter	the	relevant	information.	If	you	don’t	need	a	particular	object,	you	can	get	rid	of	it	by	selecting	it	and	pressing	the	delete	key.	On	the	other	hand,	if	you	can	copy	the	objects	if	you	need	to	add	additional	information.


